Release Notes for Nuke and Hiero 12.1v5

Release Date

06 October 2020

**Warning:** As a result of the current COVID-19 lockdown here in the UK, Foundry cannot guarantee that our usual high standards of QA have been applied to Nuke’s monitor output functionality, including VR headset support, in this release.

Qualified Operating Systems

- macOS Mojave (10.14) or macOS Catalina (10.15)
- Windows 10 (64-bit)
- CentOS 7.4 (64-bit), or later

**Note:** The VFX Platform 2019 upgrade includes library versions that are only compatible with CentOS 7.4, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke’s GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA GPUs is available at https://developer.nvidia.com/cuda-gpus

**Note:** The compute capability is a property of the GPU hardware and can’t be altered by a software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and 418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more information.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

**Note:** Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

- On Windows and Linux, an AMD GPU from the following list:

**Note:** Other AMD GPUs may work, but have not been fully tested.

- Radeon™ RX 480
- Radeon™ Pro WX 7100
- Radeon™ Pro WX 9100
- Radeon™ Pro SSG
- Radeon™ Pro WX 8200
Note: For information on the recommended driver for each GPU, see https://www.amd.com/en/support

- On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late 2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an **Enable multi-GPU support** option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

- **BUG ID 162824** - OCIOCDLTransform: Nuke now supports ASC (American Society of Cinematographers) .cdl files.
- **BUG ID 383567** - A new environment variable, NUKE_DISABLE_FRAMESERVER, has been added to enable and disable Nuke's Frame Server. Setting a value of 1, disables the Frame Server and 0 enables it.

Bug Fixes

- **BUG ID 158957** - Python: Calling **undoDescribe()** on multiple operations only returned the latest operation.
- **BUG ID 229671** - Linux only: Clicking **Import Tracks** in the CameraTracker **UserTracks** tab caused Nuke to become unresponsive.
• BUG ID 233945 - HieroPlayer: Timelines in autosaved projects could not be edited in HieroPlayer.
• BUG ID 243240 - Timeline Editing: Certain container formats, such as .mov and .mp4, added 1 frame to the start frame in the timeline when compared to the spreadsheet view.
• BUG ID 418068 - Read/Write: Files written using an Apple ProRes codec produced artifacts when read using the mov64 decoder.
• BUG ID 418354 - Dope Sheet: Setting a working frame range with Synchronise Frame Range enabled did not set the same range in the Curve Editor.
• BUG ID 429293 - HieroPlayer: Clicking Quit in the License Error dialogue caused the application to crash.
• BUG ID 438219 - Python: QComboBox() objects containing items of different lengths were not aligned correctly.
• BUG ID 438224 - Python: Adding an item to a QComboBox() after creation cut off the text in the sub-widget.
• BUG ID 439450 - OCIO: Loading certain .ccc files displayed a NameError incorrectly.
• BUG ID 439862 - Timeline Editing: Scrubbing the playhead over uncached frames caused the Viewer to jitter.
• BUG ID 443584 - CaraVR: Creating a ParticleEmitter node downstream of a C_GlobalWarp node caused Nuke to crash.
• BUG ID 443868 - Monitor Output: Certain Blackmagic Design devices occasionally became unresponsive.

New Known Issues Specific to Nuke 12.1

This section covers new known issues and gives workarounds for them, where appropriate.

**Note:** NVIDIA GPUs with compute capability of 3.0 (Kepler) cannot process .r3d files due to a known issue in the R3D SDK preventing decoding and debayering. Nuke defaults to CPU processing when reading .r3d files with these cards installed. A list of the compute capabilities of NVIDIA GPUs is available at: www.nvidia.co.uk/object/cuda_gpus.uk.html

• BUG ID 448363 - BlinkScript: Creating unsigned variables using uint displays an error when GPU acceleration is enabled.
  As a workaround, add the following line at the beginning of the kernel:
  #define uint unsigned int
• BUG ID 448084 - Python: Creating multiple QWidgets in a row does not align objects correctly by default.
• BUG ID 448081 - Python: Calling setFixedHeight() and setMaximumHeight() with QGroupBox objects does not behave consistently between Nuke 12.0 and later versions.
• BUG ID 447777 - Opening a Nuke .autosave file from the command line does not work as expected.
- BUG ID 447233 - Particles: Moving the camera in the 3D Viewer during playback of a ParticleFlock node causes Nuke to crash.

- BUG ID 447058 - LensDistortion: Setting BBox to Auto and Output Format to BBox and then undistorting and redistorting using the inverse operation in a new node does not match the original as expected.

- BUG ID 440783 - CaraVR: Attaching a Viewer to certain CaraVR node, such as C_Stitcher or C_Blender, occasionally causes views or cameras to disappear at high resolutions.

- BUG ID 440676 - F_Regrain: Rendering scripts containing F_Regrain nodes from the command line is slower than in Nuke 12.0 builds.

- BUG ID 439886 - C_CameraSolver: Setting Cam Projection to Latlong with the Cameras tab Mask > Shape set to Source does not work as expected.

- BUG ID 438947 - Node Graph: Pressing / (forward slash) to search the Node Graph by node name or class no longer highlights the previous search term.

- BUG ID 437414 - Windows only: Pressing V to display available versions on an offline shot causes Nuke Studio to crash.

- BUG ID 437221 - macOS only: System intensive Blink kernels cause Nuke to become unresponsive or crash due to an OS deadlock.

- BUG ID 436088 - C_CameraSolver: Setting the Lens Type to Rectilinear with multiple camera inputs and use GPU if available enabled renders black frames. As a workaround, disable use GPU if available.

- BUG ID 434748 - Python: nuke.message() popups created using PySide2 display the OK button incorrectly.

- BUG ID 434387 - Windows only: Setting the UI scale to 150% or higher and moving Nuke to a second monitor stops floating color pickers working as expected. As a workaround, locate the uistate.ini file here: C:\Users\<username>\.nuke\uistate.ini

Remove the ColorPicker entry under [WindowLocations]. For example:
[WindowLocations]
ColorPicker=@Rect(943 324 555 200)

- BUG ID 433153 - Viewer: Adding the custom_guides.py example file to the ..\Python\Startup/ directory disables the overlay guides popup selector.

- BUG ID 432414 - ARRIRAW: Clicking Load settings from metadata does not reset controls in the Properties panel if the current frame is outside the clip’s frame range.

- BUG ID 431603 - UI: Some filter names, such as cubic and impulse, changed case causing legacy scripts to display errors.

- BUG ID 430184 - LensDistortion: Attempting to calculate distortion on clips with anamorphic (non-square) pixel ratios constrains feature and line detection to within the square pixel ratio area of the Viewer.
- **BUG ID 427642** - Read/Write: Switching the .mov file codec control to Uncompressed occasionally displays an **Unable to open video codec** error from the Write node.

- **BUG ID 427037** - UI: Adjusting the size of the node Properties > Node tab causes the font controls to resize incorrectly.

- **BUG ID 424122** - Windows only: Adjacent menu options have no break between their highlights on high DPI screens.

- **BUG ID 420685** - Linux only: Qt does not always follow local monitor scaling correctly.

- **BUG ID 420608** - High DPI: Flipbooking to HieroPlayer on a 4K Monitor occasionally doesn’t work as expected.

- **BUG ID 420589** - C_CameraSolver: Running out of memory produces different results when matching and solving rigs.

- **BUG ID 419186** - High DPI: Dragging windows between screens with different resolutions occasionally scales the size of the window content, but not the window itself.

- **BUG ID 419183** - High DPI: Panel extend icons are not drawn correctly.

- **BUG ID 418433** - High DPI: Some panel borders exhibit artifacts or discoloration.

- **BUG ID 418315** - High DPI: The UI is rendered incorrectly when waking the computer from sleep. As a workaround, click anywhere in the UI to redraw the interface.

- **BUG ID 418027** - Windows only: The right-click menu in the Curve Editor sometimes scales to the wrong size.

- **BUG ID 417583** - C_DisparityGenerator: Processing is slower in CUDA than in OpenCL.

- **BUG ID 417418** - MXF DNxHR: Exporting files with the OP Atom and reading the files back into Nuke does not display the Tape ID metadata. In Avid, the Tape ID metadata is read correctly.

- **BUG ID 417408** - High DPI: The Preferences window doesn’t scale correctly on non-4K monitors when they are set as the primary.

- **BUG ID 417100** - Windows only: Using the ! operator on an integer image in Blink causes Nuke to crash due to a call to an unimplemented virtual function. As a workaround, add .x on the end of !p_conditions(). This avoids ! being unimplemented for int<1> on Windows.

- **BUG ID 416659** - Windows only: Disconnecting a Shuffle input and then swapping the Input Layers occasionally causes Nuke to crash.

- **BUG ID 416571** - High DPI: Pane edges are displayed with pixel artifacts in larger tabs.

- **BUG ID 416388** - High DPI: An extra line is displayed at the end of the progress bar on the Tracker node.

- **BUG ID 416134** - High DPI: The contents of a floating window don’t fit properly when moved from a non-4K monitor to a 4K monitor. As a workaround, re-scale the floating window to pop the view back into the right place.

- **BUG ID 415836** - High DPI: Properties containing a graph widget are not displaying correctly when moved to a non-4K screen.

- **BUG ID 415797** - High DPI: Node name text is not vertically centered.
• BUG ID 415673 - High DPI: When the file browser is dragged to a non-4K monitor, multiple versions of the icons appear.

• BUG ID 412221 - Backdrop: The border on Backdrop nodes in the Node Graph does not scale at different zoom levels.

• BUG ID 412218 - Backdrop: The border on Backdrop nodes in the Node Graph appears uneven at certain zoom levels.

• BUG ID 412116 - Windows only: The audio build of Nuke plays multi-channel audio at lower audible levels on Windows 10 when using SoundBlaster PCI card or a generic USB interface.

• BUG ID 410556 - High DPI: The Multiple Views (V) icon on track items is no longer transparent.

• BUG ID 406686 - Linux only: Switching from 4K to a non-4K screen can cause the UI to display incorrectly.

• BUG ID 404708 - High DPI: Moving floating panels between monitors does not work as expected if scaling is not set to 100%.

• BUG ID 399226 - High DPI: The color swatches in the Preferences are not aligned with the text.

• BUG ID 388445 - Linux only: Resetting the Workspace on a 4K monitor sends the workspace to the main monitor. If it’s not a 4K monitor, the scale doesn’t reset and context menus are not in the correct place. As a workaround, right-click anywhere in the UI to correct the scaling.

• BUG ID 388422 - High DPI: Bin items keep their orange highlighting after being deselected.

• BUG ID 384455 - Windows only: Resetting a workspace and then moving it to 4K monitor causes some panels to overlap.

• BUG ID 384433 - High DPI: After resizing the Viewer, artifacts appear above and below the Viewer controls.
Release Notes for Nuke and Hiero 12.1v4

Copyright © 2020 The Foundry Visionmongers Ltd.

Release Date

30 June 2020

⚠️ **Warning:** As a result of the current COVID-19 lockdown here in the UK, Foundry cannot guarantee that our usual high standards of QA have been applied to Nuke’s monitor output functionality, including VR headset support, in this release.

Qualified Operating Systems

- macOS Mojave (10.14) or macOS Catalina (10.15)
- Windows 10 (64-bit)
- CentOS 7.4 (64-bit), or later

📝 **Note:** The VFX Platform 2019 upgrade includes library versions that are only compatible with CentOS 7.4, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke’s GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA GPUs is available at https://developer.nvidia.com/cuda-gpus

**Note:** The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and 418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more information.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

**Note:** Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

• On Windows and Linux, an AMD GPU from the following list:

**Note:** Other AMD GPUs may work, but have not been fully tested.

- Radeon™ RX 480
- Radeon™ Pro WX 7100
- Radeon™ Pro WX 9100
- Radeon™ Pro SSG
- Radeon™ Pro WX 8200
Note: For information on the recommended driver for each GPU, see https://www.amd.com/en/support

- On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late 2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

- BUG ID 438505 - Python: Opening or closing scripts with Nuke imported as a Python module caused Nuke to crash.
- BUG ID 438743 - Soft Effects: Disabling and then enabling certain OCIOFileTransform effects caused Nuke Studio to become unresponsive.
- BUG ID 438788 - Read/Write: Artifacts occasionally displayed in the Viewer and renders for images that were more than 8192 pixels wide.
New Known Issues Specific to Nuke 12.1

This section covers new known issues and gives workarounds for them, where appropriate.

**Note:** NVIDIA GPUs with compute capability of 3.0 (Kepler) cannot process .r3d files due to a known issue in the R3D SDK preventing decoding and debayering. Nuke defaults to CPU processing when reading .r3d files with these cards installed. A list of the compute capabilities of NVIDIA GPUs is available at: [www.nvidia.co.uk/object/cuda_gpus_uk.html](http://www.nvidia.co.uk/object/cuda_gpus_uk.html)

- **BUG ID 438947** - Node Graph: Pressing / (forward slash) to search the Node Graph by node name or class no longer highlights the previous search term.
- **BUG ID 438224** - Python: Adding an item to a QComboBox() after creation cuts off the text in the sub-widget.
- **BUG ID 438219** - Python: QComboBox() objects containing items of different lengths are not aligned correctly.
- **BUG ID 437414** - Windows only: Pressing V to display available versions on an offline shot causes Nuke Studio to crash.
- **BUG ID 437221** - macOS only: System intensive Blink kernels cause Nuke to become unresponsive or crash due to an OS deadlock.
- **BUG ID 436088** - C_CamerSolver: Setting the Lens Type to Rectilinear with multiple camera inputs and use GPU if available enabled renders black frames. As a workaround, disable use GPU if available.
- **BUG ID 434748** - Python: nuke.message() popups created using PySide2 display the OK button incorrectly.
- **BUG ID 434387** - Windows only: Setting the UI scale to 150% or higher and moving Nuke to a second monitor stops floating color pickers working as expected. As a workaround, locate the uistate.ini file here:
  
  C:\Users\<username>\.nuke\uistate.ini

  Remove the ColorPicker entry under [WindowLocations]. For example:

  [WindowLocations]
  ColorPicker=@Rect(943 324 555 200)

- **BUG ID 433153** - Viewer: Adding the custom_guides.py example file to the ..//Python/Startup/ directory disables the overlay guides popup selector.
- **BUG ID 432414** - ARRIRAW: Clicking Load settings from metadata does not reset controls in the Properties panel if the current frame is outside the clip’s frame range.
- **BUG ID 431603** - UI: Some filter names, such as cubic and impulse, changed case causing legacy scripts to display errors.
• BUG ID 430184 - LensDistortion: Attempting to calculate distortion on clips with anamorphic (non-square) pixel ratios constrains feature and line detection to within the square pixel ratio area of the Viewer.

• BUG ID 429749 - Reading in QuickTime reference files causes Nuke to crash.

• BUG ID 427642 - Read/Write: Switching the .mov file codec control to Uncompressed occasionally displays an Unable to open video codec error from the Write node.

• BUG ID 427037 - UI: Adjusting the size of the node Properties > Node tab causes the font controls to resize incorrectly.

• BUG ID 425392 - NDK: OpenColorIO 1.1.1 leaks symbols from a statically linked library.

• BUG ID 424122 - Windows only: Adjacent menu options have no break between their highlights on high DPI screens.

• BUG ID 420685 - Linux only: Qt does not always follow local monitor scaling correctly.

• BUG ID 420608 - High DPI: Flipbooking to HieroPlayer on a 4K Monitor occasionally doesn't work as expected.

• BUG ID 420589 - C_CameraSolver: Running out of memory produces different results when matching and solving rigs.

• BUG ID 419186 - High DPI: Dragging windows between screens with different resolutions occasionally scales the size of the window content, but not the window itself.

• BUG ID 419183 - High DPI: Panel extend icons are not drawn correctly.

• BUG ID 418778 - Read/Write: MJPEG A and B are currently written with incorrect Matrix settings.

• BUG ID 418433 - High DPI: Some panel borders exhibit artifacts or discoloration.

• BUG ID 418315 - High DPI: The UI is rendered incorrectly when waking the computer from sleep. As a workaround, click anywhere in the UI to redraw the interface.

• BUG ID 418027 - Windows only: The right-click menu in the Curve Editor sometimes scales to the wrong size.

• BUG ID 417583 - C_DisparityGenerator: Processing is slower in CUDA than in OpenCL.

• BUG ID 417418 - MXF DNxHR: Exporting files with the OP Atom and reading the files back into Nuke does not display the Tape ID metadata. In Avid, the Tape ID metadata is read correctly.

• BUG ID 417408 - High DPI: The Preferences window doesn't scale correctly on non-4K monitors when they are set as the primary.

• BUG ID 417100 - Windows only: Using the ! operator on an integer image in Blink causes Nuke to crash due to a call to an unimplemented virtual function. As a workaround, add .x on the end of !p_conditions(). This avoids ! being unimplemented for int<1> on Windows.

• BUG ID 416659 - Windows only: Disconnecting a Shuffle input and then swapping the Input Layers occasionally causes Nuke to crash.

• BUG ID 416571 - High DPI: Pane edges are displayed with pixel artifacts in larger tabs.

• BUG ID 416388 - High DPI: An extra line is displayed at the end of the progress bar on the Tracker node.
• BUG ID 416134 - High DPI: The contents of a floating window don't fit properly when moved from a non-4K monitor to a 4K monitor.
  As a workaround, re-scale the floating window to pop the view back into the right place.
• BUG ID 415836 - High DPI: Properties containing a graph widget are not displaying correctly when moved to a non-4K screen.
• BUG ID 415797 - High DPI: Node name text is not vertically centered.
• BUG ID 415673 - High DPI: When the file browser is dragged to a non-4K monitor, multiple versions of the icons appear.
• BUG ID 412221 - Backdrop: The border on Backdrop nodes in the Node Graph does not scale at different zoom levels.
• BUG ID 412218 - Backdrop: The border on Backdrop nodes in the Node Graph appears uneven at certain zoom levels.
• BUG ID 412116 - Windows only: The audio build of Nuke plays multi-channel audio at lower audible levels on Windows 10 when using SoundBlaster PCI card or a generic USB interface.
• BUG ID 411468 - macOS only: Exporting Apple ProRes 444 .mov files displays irrelevant errors on completion.
• BUG ID 410556 - High DPI: The Multiple Views (V) icon on track items is no longer transparent.
• BUG ID 406686 - Linux only: Switching from 4K to a non-4K screen can cause the UI to display incorrectly.
• BUG ID 404708 - High DPI: Moving floating panels between monitors does not work as expected if scaling is not set to 100%.
• BUG ID 399226 - High DPI: The color swatches in the Preferences are not aligned with the text.
• BUG ID 388445 - Linux only: Resetting the Workspace on a 4K monitor sends the workspace to the main monitor. If it's not a 4K monitor, the scale doesn't reset and context menus are not in the correct place.
  As a workaround, right-click anywhere in the UI to correct the scaling.
• BUG ID 388422 - High DPI: Bin items keep their orange highlighting after being deselected.
• BUG ID 384455 - Windows only: Resetting a workspace and then moving it to 4K monitor causes some panels to overlap.
• BUG ID 384433 - High DPI: After resizing the Viewer, artifacts appear above and below the Viewer controls.
Release Notes for Nuke and Hiero
12.1v3

Release Date
11 June 2020

Warning: As a result of the current COVID-19 lockdown here in the UK, Foundry cannot guarantee that our usual high standards of QA have been applied to Nuke’s monitor output functionality, including VR headset support, in this release.

Qualified Operating Systems

- macOS Mojave (10.14) or macOS Catalina (10.15)
- Windows 10 (64-bit)
- CentOS 7.4 (64-bit), or later

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with CentOS 7.4, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke’s GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.
**NVIDIA**

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA GPUs is available at [https://developer.nvidia.com/cuda-gpus](https://developer.nvidia.com/cuda-gpus)

**Note:** The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and 418.39 (Linux), or above are required. See [https://www.nvidia.com/Download/Find.aspx](https://www.nvidia.com/Download/Find.aspx) for more information.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

**AMD**

**Note:** Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

- On Windows and Linux, an AMD GPU from the following list:

  **Note:** Other AMD GPUs may work, but have not been fully tested.

- Radeon™ RX 480
- Radeon™ Pro WX 7100
- Radeon™ Pro WX 9100
- Radeon™ Pro SSG
- Radeon™ Pro WX 8200
Note: For information on the recommended driver for each GPU, see https://www.amd.com/en/support

• On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late 2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

• BUG ID 226712 - Localization: Enabling background renders > start background render on comp save in the Preferences did not update localized frames correctly.

• BUG ID 327638 - Loading large scripts containing NukeX nodes occasionally made node connections incorrectly.

• BUG ID 332424 - Denoise: Enabling Temporal Processing on .exr clips with an out of bounds bounding box displayed CUDA errors in the Viewer.

• BUG ID 334169 - Linux only: Enabling Fullscreen mode (Alt+S) retained window borders incorrectly.
• BUG ID 381879 - LiveGroups: Selecting File > New Comp stopped LiveGroup edit warnings displaying correctly.

• BUG ID 399025 - Tracker: Enabling the Bounding Box Warning in the Preferences caused certain Group nodes not connected to the node tree to display errors, which stopped tracking working as expected.

• BUG ID 399154 - Versioning up or down with corrupted or incomplete versions available in the stack caused the application to crash.

• BUG ID 399421 - Particles: TimeOffset nodes did not pass-through ParticleEmitter transform information.

• BUG ID 400101 - High DPI: The Sparkles node bounding box outline was thinner and smaller than in older versions of Nuke.

• BUG ID 400387 - High DPI: F_RigRemoval's controls were smaller and the default removal area was more square than in older versions of Nuke.

• BUG ID 400465 - High DPI: C_CameraSolver's outline and points were thinner than in older versions of Nuke.

• BUG ID 400476 - High DPI: C_Tracker's points were thinner than in older versions of Nuke.

• BUG ID 400504 - High DPI: The AdjustBBox Viewer overlays were smaller and thinner than in older versions of Nuke.

• BUG ID 400543 - High DPI: The Wipe controls in Nuke Studio were smaller and thinner than in older versions of Nuke.

• BUG ID 401168 - High DPI: The DeepCrop Viewer widget was thinner than in older versions of Nuke.

• BUG ID 402613 - High DPI: The icons for the edit controls in the Properties panel were blurred.

• BUG ID 405258 - ReadGeo: Dragging an .abc or .fbx file into the Node Graph created a ReadGeo node, rather than a ReadGeo2 node.

• BUG ID 409405 - Versioning up a clip in the same directory as a Nuke script with the same name caused the application to crash.

• BUG ID 410543 - High DPI: The Frame Rate dropdown in the Sequence Properties in Nuke Studio was too long.

• BUG ID 413861 - Export: Re-exporting certain comps did not work as expected.

• BUG ID 415428 - Documentation: The Help > Documentation page Guide to Writing Blink Kernels link was incorrect.

• BUG ID 416120 - LiveGroups: The Node tab Copy to group button did not work as expected for LiveGroups with custom tile colors.

• BUG ID 416121 - LiveGroups: The Node tab Copy to group button did not copy custom user knobs to the Group.

• BUG ID 418261 - High DPI: The pulldown knob spacing was different to older versions of Nuke.

• BUG ID 419010 - Timeline Editing: Enabling and disabbling track visibility was slow compared to older versions of Nuke Studio.
RELEASE NOTES

• BUG ID 419697 - High DPI: The active state of certain interface elements was hard to determine due to lack of contrast.

• BUG ID 419911 - Version Linking: The Details view could not be re-ordered by link status.

• BUG ID 419924 - Selecting Cache > RAM Cache > Clear Playback Cache stopped certain .mov files playing back as expected.

• BUG ID 420675 - Linux only: The RotoPaint ripple edit outline in the Viewer did not draw correctly.

• BUG ID 422242 - High DPI: The active state of some buttons, such as the RotoPaint Viewer tools, was hard to see due to a lack of outline or contrast.

• BUG ID 430317 - LensDistortion: Enabling Viewer downrez scaled the image incorrectly if the Viewer was not attached to the LensDistortion node.

• BUG ID 431262 - Versioning up and down multiple shot selections only affected the first shot in the selection.

• BUG ID 431516 - Alembic: Dragging mutli-mesh .abc files into the Node Graph did not work as expected.

New Known Issues Specific to Nuke 12.1

This section covers new known issues and gives workarounds for them, where appropriate.

Note: NVIDIA GPUs with compute capability of 3.0 (Kepler) cannot process .r3d files due to a known issue in the R3D SDK preventing decoding and debayering. Nuke defaults to CPU processing when reading .r3d files with these cards installed. A list of the compute capabilities of NVIDIA GPUs is available at: www.nvidia.co.uk/object/cuda_gpus_uk.html

• BUG ID 436088 - C_CamerSolver: Setting the Lens Type to Rectilinear with multiple camera inputs and use GPU if available enabled renders black frames. As a workaround, disable use GPU if available.

• BUG ID 434748 - Python: nuke.message() popups created using PySide2 display the OK button incorrectly.

• BUG ID 434837 - Windows only: Setting the UI scale to 150% or higher and moving Nuke to a second monitor stops floating color pickers working as expected. As a workaround, locate the uistate.ini file here:
  C:\Users\<username>\.nuke\uistate.ini
  Remove the ColorPicker entry under [WindowLocations]. For example:
  [WindowLocations]
  ColorPicker=@Rect(943 324 555 200)

• BUG ID 433153 - Viewer: Adding the custom_guides.py example file to the ..//Python/Startup/ directory disables the overlay guides popup selector.
• BUG ID 432414 - ARRIRAW: Clicking **Load settings from metadata** does not reset controls in the **Properties** panel if the current frame is outside the clip’s frame range.

• BUG ID 431603 - UI: Some filter names, such as **cubic** and **impulse**, changed case causing legacy scripts to display errors.

• BUG ID 430184 - LensDistortion: Attempting to calculate distortion on clips with anamorphic (non-square) pixel ratios constrains feature and line detection to within the square pixel ratio area of the Viewer.

• BUG ID 429749 - Reading in QuickTime reference files causes Nuke to crash.

• BUG ID 427037 - UI: Adjusting the size of the node **Properties > Node** tab causes the **font** controls to resize incorrectly.

• BUG ID 424122 - Windows only: Adjacent menu options have no break between their highlights on high DPI screens.

• BUG ID 420685 - Linux only: Qt does not always follow local monitor scaling correctly.

• BUG ID 420608 - High DPI: Flipbooking to HieroPlayer on a 4K Monitor occasionally doesn't work as expected.

• BUG ID 420589 - C_CameraSolver: Running out of memory produces different results when matching and solving rigs.

• BUG ID 419186 - High DPI: Dragging windows between screens with different resolutions occasionally scales the size of the window content, but not the window itself.

• BUG ID 419183 - High DPI: Panel extend icons are not drawn correctly.

• BUG ID 418778 - Read/Write: MJPEG A and B are currently written with incorrect **Matrix** settings.

• BUG ID 418433 - High DPI: Some panel borders exhibit artifacts or discoloration.

• BUG ID 418315 - High DPI: The UI is rendered incorrectly when waking the computer from sleep. As a workaround, click anywhere in the UI to redraw the interface.

• BUG ID 418027 - Windows only: The right-click menu in the **Curve Editor** sometimes scales to the wrong size.

• BUG ID 417583 - C_DisparityGenerator: Processing is slower in CUDA than in OpenCL.

• BUG ID 417418 - MXF DNxHR: Exporting files with the OP Atom and reading the files back into Nuke does not display the Tape ID metadata. In Avid, the Tape ID metadata is read correctly.

• BUG ID 417408 - High DPI: The **Preferences** window doesn't scale correctly on non-4K monitors when they are set as the primary.

• BUG ID 417100 - Windows only: Using the ! operator on an integer image in Blink causes Nuke to crash due to a call to an unimplemented virtual function. As a workaround, add .x on the end of **!p_conditions()**. This avoids ! being unimplemented for int<int> on Windows.

• BUG ID 416659 - Windows only: Disconnecting a Shuffle input and then swapping the **Input Layers** occasionally causes Nuke to crash.

• BUG ID 416571 - High DPI: Pane edges are displayed with pixel artifacts in larger tabs.
• BUG ID 416388 - High DPI: An extra line is displayed at the end of the progress bar on the Tracker node.
• BUG ID 416134 - High DPI: The contents of a floating window don't fit properly when moved from a non-4K monitor to a 4K monitor. As a workaround, re-scale the floating window to pop the view back into the right place.
• BUG ID 415836 - High DPI: Properties containing a graph widget are not displaying correctly when moved to a non-4K screen.
• BUG ID 415673 - High DPI: When the file browser is dragged to a non-4K monitor, multiple versions of the icons appear.
• BUG ID 412221 - Backdrop: The border on Backdrop nodes in the Node Graph does not scale at different zoom levels.
• BUG ID 412218 - Backdrop: The border on Backdrop nodes in the Node Graph appears uneven at certain zoom levels.
• BUG ID 412116 - Windows only: The audio build of Nuke plays multi-channel audio at lower audible levels on Windows 10 when using SoundBlaster PCI card or a generic USB interface.
• BUG ID 411468 - macOS only: Exporting Apple ProRes 444 .mov files displays irrelevant errors on completion.
• BUG ID 410556 - High DPI: The Multiple Views (V) icon on track items is no longer transparent.
• BUG ID 406686 - Linux only: Switching from 4K to a non-4K screen can cause the UI to display incorrectly.
• BUG ID 404708 - High DPI: Moving floating panels between monitors does not work as expected if scaling is not set to 100%.
• BUG ID 399226 - High DPI: The color swatches in the Preferences are not aligned with the text.
• BUG ID 388445 - Linux only: Resetting the Workspace on a 4K monitor sends the workspace to the main monitor. If it’s not a 4K monitor, the scale doesn’t reset and context menus are not in the correct place. As a workaround, right-click anywhere in the UI to correct the scaling.
• BUG ID 388422 - High DPI: Bin items keep their orange highlighting after being deselected.
• BUG ID 384455 - Windows only: Resetting a workspace and then moving it to 4K monitor causes some panels to overlap.
• BUG ID 384433 - High DPI: After resizing the Viewer, artifacts appear above and below the Viewer controls.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/121/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the application programming interface (API) and application binary interface (ABI) under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>11.2v1 to 11.2v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>11.1v1 to 11.2v1</td>
<td>API</td>
<td></td>
<td>⬤</td>
</tr>
<tr>
<td>Major</td>
<td>11.0v1 to 12.0v1</td>
<td>-</td>
<td>⬤</td>
<td>⬤</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescrpts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.
Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

- BUG ID 303603 - Windows only: Calling `nuke.executeInMainThreadWithResult()` in the Script Editor displayed a `SystemError: "error return without exception set"` message.
- BUG ID 402548 - NDK: Mouse-over events called `deepEngine()` unnecessarily.
- BUG ID 405270 - Python: Moving a soft effect to a different frame Pythonically marked the effect as invalid.
- BUG ID 410467 - Python: `PyScript_Knob` keyword arguments were not called correctly within the function.
- BUG ID 420676 - Python: The `KnobChanged` callback did not update `Colorspace` knobs correctly.
- BUG ID 425392 - NDK: OpenColorIO 1.1.1 in Nuke 12.0 leaked symbols from a statically linked library.
- BUG ID 430081 - BlinkScript: Using the `normalize()` function in a Blinkscript kernel displayed an `Error compiling kernel: Error compiling kernel for GPU` error.
- BUG ID 431332 - NDK: `libstudio.so` exported `boost_python` symbols incorrectly.
- BUG ID 431656 - Python: Moving a soft effect to a different frame Pythonically caused Nuke Studio to crash.
- BUG ID 431761 - BlinkScript: The `cross()` function did not iterate correctly.
Release Notes for Nuke and Hiero 12.1v2

Release Date

08 April 2020

**Warning:** As a result of the current COVID-19 lockdown here in the UK, Foundry cannot guarantee that our usual high standards of QA have been applied to Nuke’s monitor output functionality, including VR headset support, in this release.

Qualified Operating Systems

- macOS Mojave (10.14) or macOS Catalina (10.15)
- Windows 10 (64-bit)
- CentOS 7.4 (64-bit), or later

**Note:** The VFX Platform 2019 upgrade includes library versions that are only compatible with CentOS 7.4, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke’s GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.
NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA GPUs is available at https://developer.nvidia.com/cuda-gpus

**Note:** The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and 418.39 (Linux), or above are required. See https://www.nvidia.com/Download/Find.aspx for more information.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

**Note:** Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

• On Windows and Linux, an AMD GPU from the following list:

  **Note:** Other AMD GPUs may work, but have not been fully tested.

  • Radeon™ RX 480
  • Radeon™ Pro WX 7100
  • Radeon™ Pro WX 9100
  • Radeon™ Pro SSG
  • Radeon™ Pro WX 8200
Note: For information on the recommended driver for each GPU, see https://www.amd.com/en/support

• On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late 2017 iMac Pros.

Warning: Although AMD GPUs are enabled on other Mac models, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke’s GPU support includes an Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

Note: Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

• BUG ID 284030 - Rending a node tree containing a Blinkscript node randomly generated the node_hash metadata value.
• BUG ID 377967 - SmartVectors: Adding SmartVector toolset nodes to the Node Graph displayed errors.
• BUG ID 402330 - High DPI: Denoise noise analysis messages were cut off in the Viewer.
• BUG ID 409454 - High DPI: The UI for the GridWarpTracker’s grid lines was rendering at the wrong scale on high DPI enabled monitors.
• BUG ID 409507 - High-DPI: The Viewer overlays for GridWarpTracker displayed incorrectly on 4K displays.
• BUG ID 410493 - High DPI: The current frame indicator was misaligned in the timeline.
• BUG ID 412053 - High DPI: The label field had no border when using the application in high DPI mode on a 4K monitor, and keeping the monitor scale percentage at 100%.
• BUG ID 414631 - LensDistortion: Rendering images using the frame server or command line did not work as expected.
• BUG ID 414828 - ProRes QuickTimes included incorrect color metadata, identifying the color primaries as Rec.601 rather than Rec.709.
• BUG ID 415797 - High DPI: Node name text was not vertically centered.
• BUG ID 418261 - High DPI: Column headers had changed to light gray.
• BUG ID 419156 - Windows only: Column header text was not centered correctly in tables.
• BUG ID 419489 - Kronos/OFlow: Attaching a Viewer to a Kronos or OFlow node with a negative bounding box caused Nuke to crash.
• BUG ID 419842 - PlanarTracker: Clicking the track range Viewer buttons didn’t work as expected and displayed an ExecuteDialog error.
• BUG ID 420296 - GPU Caching: Opening a script containing a C_STMap node with a Bilinear filter enabled displayed an error.
• BUG ID 420472 - High DPI: Text in the Script Editor did not appear as expected.
• BUG ID 421268 - GridWrapTracker: Undoing keyframe creation removed the grid from the Dope Sheet.
• BUG ID 421269 - GridWrapTracker: Undoing keyframe creation removed all keyframes from adjustment grids.
• BUG ID 421648 - Reading certain H.264 encoded .mp4 or .mov files failed to decode the first few frames and displayed an error.
• BUG ID 422162 - High DPI: Enabling the Lock in the Dope Sheet did not highlight the button correctly.
• BUG ID 422201 - C_STMap and Nuke’s STMap node did not always produce exactly the same result.
• BUG ID 422379 - GridWrapTracker: The track_name label did not scale correctly and could not be renamed in exports to Tracker.
• BUG ID 422385 - Version Linking: Clips added to the timeline by clicking Set Reference Media were always unlinked.
• BUG ID 422572 - C_STMap: The Radius control was missing for the Lanczos filters.
• BUG ID 423235 - macOS Catalina only: The Project export presets were not updated to reflect the deprecation of mov32 support.
• BUG ID 423239 - macOS only: Icons in Nuke’s file browser did not deselect correctly.
• BUG ID 424826 - Shuffle2: Changing the In dropdown and then undoing the action did not work as expected.
• BUG ID 426069 - Audio: Exporting .mov shots produced audio tracks that were a few milliseconds shorter that the associated video tracks.
**Release Notes for Nuke and Hiero 12.1v2 | New Known Issues Specific to Nuke 12.1**

- **BUG ID 426223** - High DPI: The view repositioning arrows were missing from the *Project Settings > Views* tab.
- **BUG ID 426894** - MOV: Exporting *.mov* formats using *mov64* codecs did not include timecode metadata.
- **BUG ID 426988** - MOV: ProRes 422HQ files were rendered incorrectly, resulting in color distortion.
- **BUG ID 427077** - Shuffle2: Copying and pasting Shuffle2 nodes containing invalid channels did not work as expected.
- **BUG ID 427420** - Windows only: *libeay32.dll* and *ssleay32.dll* were missing from the Nuke bundle, which occasionally caused PySide2 networking errors.
- **BUG ID 427430** - MXF: Rendering DNxHR *.mxf* files produced incorrect ranges from both the *Full Range* and *Video Range* options.
- **BUG ID 427475** - ZDefocus: Setting *filter type* to *image* and enabling *use input channels* displayed a *Kernel not found in cache and source is missing* error.
- **BUG ID 427502** - VectorBlur displayed an *Input is missing N.x, N.X, N.Y, N.Z* error in a customer script.
- **BUG ID 427600** - Monitor Output: Zooming in one view and then switching to a second view caused flickering on the monitor.
- **BUG ID 428784** - macOS Catalina only: Dragging clips from the *Project* bin to the *Set Reference Media* button did not work as expected.
- **BUG ID 428948** - mov64Writer: 16-bit RGB *.png* render quality was equivalent to 8-bit RGB renders.
- **BUG ID 429603** - LensDistortion: Enabling Viewer proxy or downrez modes cropped the bounding box incorrectly.
- **BUG ID 430021** - LensDistortion: Enabling Viewer proxy or downrez modes rendered output incorrectly.

### New Known Issues Specific to Nuke 12.1

This section covers new known issues and gives workarounds for them, where appropriate.

---

**Note:** NVIDIA GPUs with compute capability of 3.0 (Kepler) cannot process *.r3d* files due to a known issue in the R3D SDK preventing decoding and debayering. Nuke defaults to CPU processing when reading *.r3d* files with these cards installed. A list of the compute capabilities of NVIDIA GPUs is available at: [www.nvidia.co.uk/object/cuda_gpus uk.html](http://www.nvidia.co.uk/object/cuda_gpus uk.html)

- **BUG ID 430184** - LensDistortion: Attempting to calculate distortion on clips with anamorphic (non-square) pixel ratios constrains feature and line detection to within the square pixel ratio area of the Viewer.
- **BUG ID 430081** - BlinkScript: Using the `normalize()` function in a Blinkscript kernel displays an *Error compiling kernel: Error compiling kernel for GPU* error.
- **BUG ID 429749** - Reading in QuickTime reference files causes Nuke to crash.
• BUG ID 427642 - MOV: Writing .mov files using the Uncompressed codec occasionally displays an Unable to open video codec error.

• BUG ID 427037 - UI: Adjusting the size of the node Properties > Node tab causes the font controls to resize incorrectly.

• BUG ID 425049 - Audio: Deleting an audio clip during timeline playback causes unexpected behavior.

• BUG ID 424122 - Windows only: Adjacent menu options have no break between their highlights on high DPI screens.

• BUG ID 423133 - Read: Reverting a change to the Clip Settings > Colorspace or Look > Colorspace dropdowns for certain .ari and .r3d files displays an Invalid LUT error in the Viewer.

• BUG ID 420685 - Linux only: Qt does not always follow local monitor scaling correctly.

• BUG ID 420608 - High DPI: Flipbooking to HieroPlayer on a 4K Monitor occasionally doesn’t work as expected.

• BUG ID 420589 - C_CameraSolver: Running out of memory produces different results when matching and solving rigs.

• BUG ID 419808 - BlinkScript: The normalize function doesn’t work as expected.

• BUG ID 419186 - High DPI: Dragging windows between screens with different resolutions occasionally scales the size of the window content, but not the window itself.

• BUG ID 419183 - High DPI: Panel extend icons are not drawn correctly.

• BUG ID 418778 - Read/Write: MJPEG A and B are currently written with incorrect Matrix settings.

• BUG ID 418433 - High DPI: Some panel borders exhibit artifacts or discoloration.

• BUG ID 418315 - High DPI: The UI is rendered incorrectly when waking the computer from sleep. As a workaround, click anywhere in the UI to redraw the interface.

• BUG ID 418027 - Windows only: The right-click menu in the Curve Editor sometimes scales to the wrong size.

• BUG ID 417583 - C_DisparityGenerator: Processing is slower in CUDA than in OpenCL.

• BUG ID 417418 - MXF DNxHR: Exporting files with the OP Atom and reading the files back into Nuke does not display the Tape ID metadata. In Avid, the Tape ID metadata is read correctly.

• BUG ID 417408 - High DPI: The Preferences window doesn’t scale correctly on non-4K monitors when they are set as the primary.

• BUG ID 417100 - Windows only: Using the ! operator on an integer image in Blink causes Nuke to crash due to a call to an unimplemented virtual function. As a workaround, add .x on the end of !p_conditions(). This avoids ! being unimplemented for int<1> on Windows.

• BUG ID 416659 - Windows only: Disconnecting a Shuffle input and then swapping the Input Layers occasionally causes Nuke to crash.

• BUG ID 416571 - High DPI: Pane edges are displayed with pixel artifacts in larger tabs.

• BUG ID 416388 - High DPI: An extra line is displayed at the end of the progress bar on the Tracker node.
• BUG ID 416134 - High DPI: The contents of a floating window don't fit properly when moved from a non-4K monitor to a 4K monitor. As a workaround, re-scale the floating window to pop the view back into the right place.
• BUG ID 415836 - High DPI: Properties containing a graph widget are not displaying correctly when moved to a non-4K monitor.
• BUG ID 415673 - High DPI: When the file browser is dragged to a non-4K monitor, multiple versions of the icons appear.
• BUG ID 412221 - Backdrop: The border on Backdrop nodes in the Node Graph does not scale at different zoom levels.
• BUG ID 412218 - Backdrop: The border on Backdrop nodes in the Node Graph appears uneven at certain zoom levels.
• BUG ID 412116 - Windows only: The audio build of Nuke plays multi-channel audio at lower audible levels on Windows 10 when using SoundBlaster PCI card or a generic USB interface.
• BUG ID 411468 - macOS only: Exporting Apple ProRes 444 .mov files displays irrelevant errors on completion.
• BUG ID 410556 - High DPI: The Multiple Views (V) icon on track items is no longer transparent.
• BUG ID 406686 - Linux only: Switching from 4K to a non-4K screen can cause the UI to display incorrectly.
• BUG ID 404708 - High DPI: Moving floating panels between monitors does not work as expected if scaling is not set to 100%.
• BUG ID 399226 - High DPI: The color swatches in the Preferences are not aligned with the text.
• BUG ID 388445 - Linux only: Resetting the Workspace on a 4K monitor sends the workspace to the main monitor. If it's not a 4K monitor, the scale doesn't reset and context menus are not in the correct place. As a workaround, right-click anywhere in the UI to correct the scaling.
• BUG ID 388422 - High DPI: Bin items keep their orange highlighting after being deselected.
• BUG ID 384455 - Windows only: Resetting a workspace and then moving it to 4K monitor causes some panels to overlap.
• BUG ID 384433 - High DPI: After resizing the Viewer, artifacts appear above and below the Viewer controls.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/121/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the application programming interface (API) and application binary interface (ABI) under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>11.2v1 to 11.2v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>11.1v1 to 11.2v1</td>
<td>API</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>11.0v1 to 12.0v1</td>
<td>-</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke’s node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.
Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

• BUG ID 427650 - Python: Icons created Pythonically were not visible in the top menu bar in the Timeline environment.
Release Notes for Nuke and Hiero
12.1v1

Release Date
19 February 2020

Qualified Operating Systems

- macOS Mojave (10.14) or macOS Catalina (10.15)
- Windows 10 (64-bit)
- CentOS 7.4 (64-bit), or later

Note: The VFX Platform 2019 upgrade includes library versions that are only compatible with CentOS 7.4, or later. Nuke 12.1 is qualified on the Centos 7.4, 7.5, and 7.6 distributions.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 3.0 (Kepler) or above. A list of the compute capabilities of NVIDIA GPUs is available at https://developer.nvidia.com/cuda-gpus
**Note:** The compute capability is a property of the GPU hardware and can’t be altered by a software update.

With graphics drivers capable of running CUDA 10.1 or above. On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver versions 418.96 (Windows) and 418.39 (Linux), or above are required. See [https://www.nvidia.com/Download/Find.aspx](https://www.nvidia.com/Download/Find.aspx) for more information.

**Note:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

**Note:** Bit-wise equality between GPU and CPU holds in most cases, but for some operations there are limitations to the accuracy possible with this configuration.

• On Windows and Linux, an AMD GPU from the following list:

  **Note:** Other AMD GPUs may work, but have not been fully tested.

  • Radeon™ RX 480
  • Radeon™ Pro WX 7100
  • Radeon™ Pro WX 9100
  • Radeon™ Pro SSG
  • Radeon™ Pro WX 8200

  **Note:** For information on the recommended driver for each GPU, see [https://www.amd.com/en/support](https://www.amd.com/en/support)

• On Mac, AMD GPUs are supported on any late 2013 Mac Pro, mid 2015 MacBook Pros onward, and late 2017 iMac Pros.
Warning: Although AMD GPUs are enabled on other Mac models, they are not officially supported and used at your own risk.

Multi-GPU Processing

Nuke's GPU support includes an **Enable multi-GPU support** option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

**Note:** Multi-GPU processing is only available for identical GPUs in the same machine. For example, two NVIDIA GeForce GTX 1080s or two AMD Radeon™ Pro WX 9100s.

New Features

**Blink Particles**

For Nuke 12.1 we have added the ParticleBlinkScript node. This node works in a similar way to the BlinkScript node but allows you to write Blink scripts that operate on particles. This enables you to write your own Particle nodes, to create the specific behavior you need.

Additionally, we are providing new particle gizmos written with ParticleBlinkScript. This adds new behavior and functionality to the Particle system, and each node includes the script available as a teaching tool.

**DDImage Update**

Nuke 12.1 contain an update to DDImage to separate the codec knobs from the container knobs. This update breaks binary compatibility for any and all plug-ins built against previous versions of DDImage.

**FFMpeg Update**

The FFmpeg libraries have been updated to version 4.2. The main benefits are related to file I/O, but in general use, we do not expect you to see any difference. You may experience problems with different system versions if they override our library path or if your system contains mismatching dependencies from the original CentOS 7.4 packages.
GPU Caching and Improvements

For Nuke 12.1 we have made improvements to Nuke’s GPU processing, enabling images to be cached on the GPU between nodes for faster execution of chains of GPU nodes. This behavior is available for all CaraVR nodes in NukeX and BlinkScript. Scripts with chains of these nodes keep data on the GPU, rather than transferring to and from the CPU in between nodes. We expect significant performance improvements for chains of these nodes processed on GPU.

Additional updates include:

- Improvements to the overall Blink infrastructure resulting in performance improvements to all GPU accelerated nodes.
- SphericalTransform2 has a new MirrorBall projection method and access to the standard set of Nuke filter methods. SphericalTransform2 replaces Nuke’s existing SphericalTransform node.

**Note:** Backwards compatibility for scripts using C_SphericalTransform is provided.

- Bilateral2 has a new Median filter method. Bilateral2 replaces Nuke’s existing Bilateral node.

**Note:** Backwards compatibility for scripts using C_Bilateral is provided.

- C_Blur options added to blur in latlong or rectilinear space to match Nuke’s native Blur node.
- C_STMap now includes the standard set of Nuke filter methods.

GridWarpTracker

You can now export tracking data from GridWarpTracker to Nuke’s regular Tracker node by right-clicking in the Viewer and selecting Export to and selecting the export type.

HieroPlayer Flipbook and Fast Launch

Nuke 12.1 includes the ability to use HieroPlayer as a flipbook tool for Nuke and NukeX, giving artists more control when comparing different versions of their work. HieroPlayer auto-detects the OCIO config and Viewer colorspace coming from the Nuke script and sets up the files being reviewed correctly, whether you are working on a single script or in multiple scripts at one given time. HieroPlayer can be set as the Flipbook in the UI and in the Preferences.
The launch speed of HieroPlayer has also been improved across all operating systems to improve the overall experience of using HieroPlayer as a flipbook tool.

### High DPI Support

Nuke supports high definition displays, automatically scaling the interface using the operating system's scaling settings. On Linux operating systems, scaling is currently disabled by default. You can enable automatic scaling by setting the QT_AUTO_SCREEN_SCALE_FACTOR environment variable to 1.

**Note:** Auto-scaling in some multi-screen setups causes the interface to scale incorrectly when moving from lower resolution screens to higher resolution screens. This is possibly a symptom of the way Qt calculates screen scale.

To avoid this issue, we recommend always placing your physical screens with the highest resolution on the far left-hand side of the setup.

Alternatively, you can set the screen scaling factor manually using the QT_SCALE_FACTOR environment variable to force scaling to 1, 1.5, or 2. The recommended scaling factor is 1.5.

In multi-monitor setups, you can manually scale the interface independently by screen using the QT_SCREEN_SCALE_FACTORS variable. Scaling uses the same recommended factors, separated by ; (semicolon). For example, QT_SCREEN_SCALE_FACTORS="1.5;1" where the first monitor is higher resolution than the second.

We are working on providing user preferences to replace variables and hope to have these available in an upcoming release. This is currently logged as:

- BUG ID 420052 - High DPI: Add UI scaling options to preferences.

### LensDistortion

This release includes a new user-friendly UI redesign for streamlined workflow, with improved automatic bounding box detection and improved viewer interaction.

### OCIO Gamma and Gain

The GPU viewer now works when using OCIO color management. Unfortunately, because of some limitations in the OCIO 1.1.1 library, the CPU and GPU Viewer paths might give slightly different results. We would like to know if the differences between the viewers are acceptable, or if we should disable OCIO GPU acceleration in the Viewer until better GPU support can be provided via the OCIO library.
To see the change, enable OCIO color management in the Project Settings > Color tab, and the enable use GPU for viewer when possible in the Viewer Properties panel.

QuickTime Audio

Native support of .mov files containing audio has been expanded to include Linux and Windows. You can now import these .mov files directly into Nuke Studio, Hiero, and HieroPlayer without the need to extract and import the audio as a separate .wav file.

Shuffle

Nuke 12.1 introduces an updated Shuffle2 node, which replaces both the Shuffle and ShuffleCopy nodes. It has an updated, more user-friendly UI, supports one or two inputs, and up to eight channels per layer. The new user interface features a node-like visual indicator of which channels are being copied. Connections are made by dragging sockets between layers. Inputs can have multiple outgoing connections, but outputs can only have one incoming channel. Channels can be set to solid black or solid white, by selecting the black or white button in the Output Layer.

Input and output channel layers can be set individually, using the channels dropdown. The source of the selected layer’s channel data can be set using the dropdown on the respective Input Layer. When connections have been made, but the Shuffle’s input pipe becomes disconnected, the connections from Input to Output are represented with dotted lines.

Surround Sound Support

This release includes multi-channel audio support in NukeStudio, Hiero, and HieroPlayer. When you import 5.1 and 7.1 or individual audio files and place them on your timeline, the audio tracks can now be patched to different output speakers, such as LFE or Center. Audio output is configurable using monitor out devices or specific audio cards.

Version Linking

Version Linking allows linking and unlinking of source clip versions between project bin clips and shots in a sequence that reference a clip. You can define if a shot is linked to its source clip or not, and we’ve introduced three new states to bin clips: Linked, Unlinked and Mixed. Two new states govern shots: Linked or Unlinked.

These states are indicated by an icon on the clips that have been unlinked and there is a new column in the Project bin and spreadsheet view for Version and Link Status. Bin clips can be set as Linked or Unlinked on import using the Preferences > Project Defaults > General > Link bin and track item version.
Feature Enhancements

File Format Updates

DNxHR MXF Writer for Nuke (Video only)

MXF format added to Write Node - File Type

DNxHR codec support

OP-1a and OP-Atom Patterns

Profiles

• 4:4:4 12-bit
• HQX 4:2:2 12-bit
• HQ 4:2:2 8-bit
• SQ 4:2:2 8-bit
• LB 4:2:2 8-bit

Improvements to Reading .mxf and .mov Files

Nuke now uses file metadata to set the colorspace in Nuke for .mov and .mxf ProRes files. If no metadata exists, Nuke parses frame header information to retrieve transfer characteristics.

Note: Legacy scripts may not work as expected as a result of this update.

Additional support includes:

• Motion JPEG B - Reader using mov64
• Motion JPEG B - Writer using mov64 (Nuke only)
• Colorfront encoded DNxHD Op-Atom .mxf files are now supported.

Avid DNx Codec 2.3.1 Update

Nuke can now read DNxHR .mov files and additional SDK info is now displayed in Read node’s Properties panel.
ArriRAW 6.2.1.0 Update

Nuke can now read Arri Codex HDE .arx and Alexa Mini LF files and additional SDK info is now displayed in Read node's Properties panel. CUDA GPU debayering is now available for NVIDIA cards.

ARRI Apple ProRes Update

Nuke now supports ARRI Apple ProRes wrapped in .mxf files.

Bug Fixes

- **BUG ID 155170** - ParticleEmitter: The controls on the Region tab were enabled by default.
- **BUG ID 216355** - mov64Reader: Reading files written with the Animation codec produced blurred images when compared to the mov32Reader.
- **BUG ID 271930** - Soft Effects: Opening a project in HieroPlayer allowed editing of the Viewer overlay.
- **BUG ID 363911** - When color management was set to OCIO, adjusting the Gain/Gamma values or changing the channels in the Viewer reset the playback cache.
- **BUG ID 379710** - GridWarpTracker: Pressing the Esc key did not cancel tracking as expected.
- **BUG ID 388455** - High DPI: Hovering down a menu list left orange highlight outlines around items.
- **BUG ID 390885** - GridWarpTracker: Morph Amount was disabled when going from Warp to Morph.
- **BUG ID 393106** - LensDistortion: Solves didn’t produce reliable results on anamorphic footage, even though lines were detected correctly.
- **BUG ID 394019** - Qt: Floating windows changed Z position when full screen mode was enabled using Ctrl/Cmd+Shift+F or Ctrl/Cmd+F.
- **BUG ID 395305** - Nuke Studio paused for a few seconds after loading a project.
- **BUG ID 400232** - High DPI: CameraTracker’s thumbnails bar was not scaled to fit the width of Viewer.
- **BUG ID 400508** - High DPI: The Wipe bounding box outline was thinner and smaller than in older versions of Nuke.
- **BUG ID 407395** - Particles: Connecting and viewing ParticleEmitter and ParticleSpawn nodes caused Nuke to crash.
- ** BUG ID 408079** - GridWarpTracker: Using SmartVector tracking data did not work as expected if the Viewer downrez control was set to anything other than 1:1.
- **BUG ID 410741** - Read/Write: Nuke did not read 12-bit (4444) ProRes .mov files correctly.
- **BUG ID 411453** - BlinkScript: The kernel editor in the node Properties panel used an incorrect font.
• BUG ID 414242 - ParticleExpression: A divide by zero error in the 3D system caused Nuke to crash.
• BUG ID 416170 - Linked knobs didn't display their custom knob name and tooltip correctly.
• BUG ID 416264 - Linux only: Reading multiple ARRIRAW files in Nuke Studio or Hiero caused the application to become unresponsive or crash.
• BUG ID 417574 - Loading a preferences file containing an unknown preference caused Nuke to crash.
• BUG ID 417703 - LensDistortion: Drawing features with a sampling region active in the Viewer did not work as expected.
• BUG ID 418206 - Particles: Connecting a particle stream from a TimeOffset node to a geometry node, such as MergeGeo, did not produce any geometry.
• BUG ID 418831 - Export: Projects with multiple versions and burn-in applied caused the Export dialog to appear sluggish.
• BUG ID 419490 - ParticleExpression: Viewing a ParticleExpression node with chans set to any expression and new_channels set to None caused Nuke to crash.
• BUG ID 420623 - Audio: Changing audio device did not work without restarting the application and occasionally caused Nuke Studio to crash.
• BUG ID 420674 - macOS only: Flipbooking did not set the Viewer LUT to None.
• BUG ID 421100 - WriteGeo: The Execute button did not work as expected.
• BUG ID 421318 - Timeline Editing: Disabling and enabling shots with transitions or burn-ins applied occasionally displayed artifacts in the Viewer.
• BUG ID 422056 - ParticleToGeo: 2D sprites were not affected by the align mode.
• BUG ID 422500 - Monitor Output: Applying certain Viewer masks produced artifacts in the mask areas with Blackmagic 10-bit 4:4:4 output.
• BUG ID 422682 - GridWarpTracker: The undo stack incorrectly grouped multiple actions together into a single undo.

New Known Issues Specific to Nuke 12.1

This section covers new known issues and gives workarounds for them, where appropriate.

**Note:** NVIDIA GPUs with compute capability of 3.0 (Kepler) cannot process .r3d files due to a known issue in the R3D SDK preventing decoding and debayering. Nuke defaults to CPU processing when reading .r3d files with these cards installed. A list of the compute capabilities of NVIDIA GPUs is available at: [www.nvidia.co.uk/object/cuda_gpus uk.html](http://www.nvidia.co.uk/object/cuda_gpus uk.html)

• BUG ID 426069 - Audio: Exporting .mov shots produces audio tracks that are a few milliseconds shorter that the associated video tracks.
• BUG ID 424122 - Windows only: Adjacent menu options have no break between their highlights on high DPI screens.

• BUG ID 423133 - Read: Reverting a change to the Clip Settings > Colorspace or Look > Colorspace dropdowns for certain .ari and .r3d files displays an Invalid LUT error in the Viewer.

• BUG ID 422242 - High DPI: The active state of some buttons, such as the RotoPaint Viewer tools, can be hard to see due to a lack of outline or contrast.

• BUG ID 420685 - Linux only: Qt does not always follow local monitor scaling correctly.

• BUG ID 420608 - High DPI: Flipbooking to HieroPlayer on a 4K Monitor occasionally doesn’t work as expected.

• BUG ID 420589 - C_CameraSolver: Running out of memory produces different results when matching and solving rigs.

• BUG ID 419842 - PlanarTracker: Clicking the track range Viewer buttons doesn't work as expected and displays an ExecuteDialog error.

• BUG ID 419808 - BlinkScript: The normalize function doesn't work as expected.

• BUG ID 419186 - High DPI: Dragging windows between screens with different resolutions occasionally scales the size of the window content, but not the window itself.

• BUG ID 419183 - High DPI: Panel extend icons are not drawn correctly.

• BUG ID 419156 - Windows only: Column header text is not centered correctly in tables.

• BUG ID 418778 - Read/Write: MJPEG A and B are currently written with incorrect Matrix settings.

• BUG ID 418433 - High DPI: Some panel borders exhibit artifacts or discoloration.

• BUG ID 418315 - High DPI: The UI is rendered incorrectly when waking the computer from sleep. As a workaround, click anywhere in the UI to redraw the interface.

• BUG ID 418251 - High DPI: Column headers have changed to light gray.

• BUG ID 418027 - Windows only: The right-click menu in the Curve Editor sometimes scales to the wrong size.

• BUG ID 417583 - C_DisparityGenerator: Processing is slower in CUDA than in OpenCL.

• BUG ID 417418 - MXF DNxHR: Exporting files with the OP Atom and reading the files back into Nuke does not display the Tape ID metadata. In Avid, the Tape ID metadata is read correctly.

• BUG ID 417408 - High DPI: The Preferences window doesn't scale correctly on non-4K monitors when they are set as the primary.

• BUG ID 417100 - Windows only: Using the ! operator on an integer image in Blink causes Nuke to crash due to a call to an unimplemented virtual function. As a workaround, add .x on the end of !p_conditions(). This avoids ! being unimplemented for int<1> on Windows.

• BUG ID 416659 - Windows only: Disconnecting a Shuffle input and then swapping the Input Layers occasionally causes Nuke to crash.

• BUG ID 416571 - High DPI: Pane edges are displayed with pixel artifacts in larger tabs.
• BUG ID 416388 - High DPI: An extra line is displayed at the end of the progress bar on the Tracker node.
• BUG ID 416134 - High DPI: The contents of a floating window don't fit properly when moved from a non-4K monitor to a 4K monitor. As a workaround, re-scale the floating window to pop the view back into the right place.
• BUG ID 415836 - High DPI: Properties containing a graph widget are not displaying correctly when moved to a non-4K screen.
• BUG ID 415797 - High DPI: Node name text is not vertically centered.
• BUG ID 415673 - High DPI: When the file browser is dragged to a non-4K monitor, multiple versions of the icons appear.
• BUG ID 414828 - ProRes QuickTimes include incorrect color metadata, identifying the color primaries as Rec.601 rather than Rec.709.
• BUG ID 412221 - Backdrop: The border on Backdrop nodes in the Node Graph does not scale at different zoom levels.
• BUG ID 412218 - Backdrop: The border on Backdrop nodes in the Node Graph appears uneven at certain zoom levels.
• BUG ID 412116 - Windows only: The audio build of Nuke plays multi-channel audio at lower audible levels on Windows 10 when using SoundBlaster PCI card or a generic USB interface.
• BUG ID 411468 - macOS only: Exporting Apple ProRes 444.mov files displays irrelevant errors on completion.
• BUG ID 411328 - macOS only: Switching between sequences occasionally causes Nuke Studio to crash.
• BUG ID 410556 - High DPI: The Multiple Views (V) icon on track items is no longer transparent.
• BUG ID 410493 - High DPI: The current frame indicator is misaligned in the Nuke Studio timeline.
• BUG ID 407193 - High DPI: The divider line in the A/B dropdown is not sharp.
• BUG ID 406686 - Linux only: Switching from 4K to a non-4K screen can cause the UI to display incorrectly.
• BUG ID 404708 - High DPI: Moving floating panels between monitors does not work as expected if scaling is not set to 100%.
• BUG ID 399226 - High DPI: The color swatches in the Preferences are not aligned with the text.
• BUG ID 394981 - C_Blur and Nuke’s Blur node do not always produce exactly the same result.
• BUG ID 388445 - Linux only: Resetting the Workspace on a 4K monitor sends the workspace to the main monitor. If it's not a 4K monitor, the scale doesn't reset and context menus are not in the correct place. As a workaround, right-click anywhere in the UI to correct the scaling.
• BUG ID 388422 - High DPI: Bin items keep their orange highlighting after being deselected.
• BUG ID 384455 - Windows only: Resetting a workspace and then moving it to 4K monitor causes some panels to overlap.
• BUG ID 384433 - High DPI: After resizing the Viewer, artifacts appear above and below the Viewer controls.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or https://learn.foundry.com/nuke/developers/121/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the application programming interface (API) and application binary interface (ABI) under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plug-ins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>11.2v1 to 11.2v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>11.1v1 to 11.2v1</td>
<td>API</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>11.0v1 to 12.0v1</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke’s node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescrpts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.
Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

There are no bug fixes in this release.